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[Product covered in this Manual]
This manual covers the Clontech PCR Thermal Cycler GP.

Clontech PCR Thermal Cycler GP (Cat. #WN400)

[Introduction]

A Note: Our products are to be used for Research Use Only. They may not be
used for any other purpose, including, but not limited to, use in
humans, therapeutic or diagnostic use, or commercial use of any kind.

This instrument must not be used by any person other than those with
special knowledge.

When this instrument is used for experiments, individual conditions must be
carefully examined. Takara Bio Inc. shall not be liable to the results of such
experiments and the consequences thereof.

The product specifications, appearance, and this product manual may be
subject to change without notice for improvement.

If the instrument is used in a condition other than those specified in this
manual, it may malfunction or be damaged.

Takara Bio Inc. shall not be liable for any obligations under the warranty
provisions nor any damages resulting therefrom when the instrument is
repaired, disassembled or modified (including the use of software other
than that included with the instrument, infection by computer virus) or
when the instrument is used in neglect of the requirements described in
this manual, including "Safety Precautions for Takara Bio Instrument.”

All trademarks are the property of their respective owners. Certain
trademarks may not be registered in all jurisdictions.

[Warranty]

For the warranty period concerning failure, damage, etc., check the contents
of the warranty document included with the product.
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Safety Precautions for Takara Bio Instrument

Before opening the package, setup and operation of the instrument purchased,
please read this manual carefully to fully understand the contents.

After you have read it, keep it in a location that can be accessed at any time
when you use the instrument.

Pay particular attention to the precautions for safety and against possible danger
(Danger, Warning, and Caution) described in this manual.

If the instrument is used in neglect of the Danger, Warning, and Caution
requirements, serious personal injury or damage to the product may result.

1. Precaution Symbols

Various precaution symbols are provided on the instrument and in the manual
to ensure safe use of the instrument and to prevent hazards to the customer

and other people as well as property damage.

Read the descriptions after fully understanding the meanings of these symbols.

May cause death or serious
DANG ER injury of the user.

If the instrument is operated

WARNING incorrectly while neglecting this
symbol, a serious accident may
result.

If the instrument is operated

CAUTION incorrectly while neglecting this

symbol, an accident may result.
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2. Precautions for Takara Bio Instruments

When using this product, the following precautions must be followed to
ensure the performance of the instrument and to prevent the risk of fire and
electric shock. Read this manual carefully to ensure correct use.

2.1. Precautions Regarding the Place of Installation

Follow the instructions below for setup.

A WARNING

CAUTION

Do not place the instrument on an
unstable place, such as on a wobbly
table or on a tilted surface.

If the instrument falls to the floor or
is damaged, immediately turn off the
power of the instrument and the
peripheral instrument connected to
it, then disconnect the power plug
from the outlet.

Do not block the ventilation holes on
the instrument if provided. Blocking
the holes can cause heat to
accumulate inside the instrument,
resulting in burns or a fire.

Keep the instrument away from
humid and dusty places. Do not place
the instrument in a location subject
to vibrations.

Do not expose the instrument to
direct sunlight or high temperatures.
The internal temperature may rise,
resulting in burns or a fire.

Do not place any object on the
instrument.

Do not install the product in a
location other than a research
facility or the equivalent.
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2.2. Electrical Precautions

Follow the precautions below when using an electricity powered instruments.

DANGER

CAUTION

Clontech PCR Thermal Cycler GP

The unit, power cable, and AC
adapter carry high voltage. Do not
insert metal or inflammable objects
in the instrument or touch it with wet
hands. There is a risk of fire or
electric shock.

Do not use the instrument at a
voltage other than the specified
voltage.

Do not damage, break, modify,
excessively bend or twist the power
cable or AC adapter. In addition, do
not place any object on or apply heat
to the cable, and do not pull it
forcibly.

To prevent electric shock due to
electric leakage, make sure to
ground the unit.

Before connecting the instrument to
the outlet, always make sure that the
maximum current indicated on the
instrument does not exceed the
allowable current of the outlet. When
connecting multiple instrument, be
careful that the total power
consumption of the instrument to be
connected does not exceed the
allowable current.

Before moving the instrument, make
sure to unplug the power cable from
the outlet and disconnect the cables
from the external instrument.

Before cleaning, unplug the power
cable from the outlet for safety.
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2.3. Other Precautions

Follow the following precautions:

Do not attempt repairs of any

DANGER electrical, mechanical, or tubing

components inside the instrument on
your own.

Do not insert foreign objects like
metal or flammable materials into the
instrument through the opening.
Do not modify or disassemble the
instrument. Doing so may impair the
unit’s intended performance.
Additionally, electric shock or damage
may result, or the internally stored
settings may be lost.

- If you notice smoke, a strange smell,
A WARNING or other abnormal conditions,

immediately stop operation, turn off

the power, and disconnect the power
cable from the outlet. Wait until the
abnormal condition has settled before
contacting your distributor.
If foreign objects or water enters the
instrument, stop operation immediately,
turn off the power, disconnect the
power cable from the outlet, and then
contact the distributor.

Do not step on the instrument.
Do not disassemble the instrument.

- Do not open the instrument during
CAUTION analysis.

- Make sure to use the reaction tubes
and reaction plates for this instrument
listed at the end of this manual.




Product Manual Clontech PCR Thermal Cycler GP

3. Warning Labels

Warning symbol labels are affixed to the body to ensure safe operation. Check
the details of the associated hazards before use.

Warning Hazard .
. Details of Danger
Symbol Section °
Warning: Electrical shock!
Do not open the power supply.
Power . .
supply There is a danger of electric shock
due to the high voltage of the power
supply.
Warning: Make sure to connect the ground wire.
To prevent electric shock, this
Power .
cable instrument must be grounded.
Electric shock or fire may be caused
due to electrical leakage.
Caution: High temperature!
Heat block 9 P .
Heat lid Be careful not to burn your skin as the
heat block and heat lid become hot.
4.Symbols

4.1. Electrical Symbols

Symbols used for the power switch.

| Power ON status

O Power OFF status

4.2. Warning Symbols

”

These symbols are shown in ”3. Warning Labels”.

A Indicates hazards or cautions
® Indicates prohibited actions

. Follow the product manual.
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1. Overview of the Product

Clontech PCR Thermal Cycler GP is a compact PCR Product. The 5 inch High-Definition
Full Touch TFT LCD color display allows you to view the entire program graphically in
real time and to control parameter changes intuitively. In addition, the latest
semiconductor technology provides excellent temperature accuracy and uniformity,
which provides stable experimental results.

1.1. Features of the Instrument

Compact size and simple user interface for easy and comfortable operation.
The latest semiconductor technology provides high temperature uniformity
throughout the heat block, making temperature control of the program
more accurate.

The system has a built-in temperature gradient calculation function, which
can be set up easily. Precise annealing temperatures can be calculated to
help optimize PCR reaction conditions for a variety of experimental samples.
The flexible heat-lid construction allows use of tubes of different length to
maintain optimal temperature conditions for testing.
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1.2. Structure of the Instrument

The structure of the instrument is shown below. Check the descriptions of
each part before using the instrument for the first time.

\ Lid open/close button

High temperature
caution symbol

Heat lid

Heat block

High temperature
caution symbol

LCD display

Exhaust holes

Power switch

USB port

Lid

Serial seal

Fuse holder

Power connector

10
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1.3. Specifications of the Product

: 280 mm (D) x 185 mm (W) x 165 mm (H)
: 4.3 kg
: AC100-240V,50/60 Hz, 6.6 - 3.1 A

- External dimensions
- Weight
- Power supply

11

- Preset temperature range 1 41t099.9°C

- Sample volume 1 96x0.2ml

- Maximum heating rate : 4.5°C/s

- Maximum cooling rate : 4°C/s

- Temperature uniformity : *£0.5°C at 50°C

- Temperature accuracy : *£0.5°C

- Temperature indication resolution : 0.1°C

- Temperature gradient range : 30t099.9°C

- Temperature gradient difference range : 0.1to 30°C

- Heat lid temperature range : 30to 110°C

- Maximum number of steps : 30

- Maximum number of cycles : 99

- Time increment/decrement : -599to +599 s

- Temperature increase/decrease : -9.9 to +9.9°C

- Program pause function : Available

- Display : 5inch color touch panel,
800 x 480 pixels

- Number of programs saved : <500

- Communication port : USB 2.0
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2. Setup Instructions

The setup instructions of the instrument are shown below. Read this section
carefully before using the instrument for the first time.

2.1. Unpacking

As soon as you receive the instrument, check it and its accessories according
to the packing list. Contact your distributor if there is any discrepancy with
the packing list.

2.2. Setup

<Setup procedure>

1. Check that the power supply specification satisfies the requirements.

2. Make sure that the Power Switch of the instrument is OFF.

3. Connect the power cable to the instrument and insert the power plug into
the grounded power outlet.

4. Turn on the power to the instrument.

A Caution 1: When handling the instrument, follow the instructions below.

This instrument is designed for use in an indoor environment.

Connect or disconnect the power cable by holding the plug with your
hand. When inserting the plug, make sure that the plug is fully inserted
into the outlet. Do not pull the power cable to unplug the instrument.
Keep the instrument away from moisture and avoid direct sunlight or
intense light sources. Use in a well-ventilated room without corrosive
gas nor strong magnetic field interference. Keep away from heat
sources like heaters, stoves, and the like. Do not place the instrument
in a humid or dusty environment.

Turn off the power once the instrument stops operating. If the
instrument is not used for an extended period of time, remove the
power plug and protect the instrument with a soft cloth to prevent dust
from entering.

A Caution 2: In the following cases, immediately unplug the cable from the
outlet and contact your distributor.

If any liguid enters the instrument

If an abnormal sound or smell is detected inside the instrument
If the instrument becomes wet with water or rain

If the instrument falls from the table or its enclosure is damaged
If the function of the instrument is abnormal

12
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2.3. Setup Conditions

Ambient temperature : 10 - 30°C
Humidity : =70%
Power supply : AC100-240V, 50/60 Hz, 6.6 - 3.1 A

13
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3. Protocol

The basic operations are as follows. Read this section carefully before using the
instrument for the first time.

3.1. Start Up

1. When the power switch is turned on, the display screen lights up and the
following welcome screen appears.

Clontech

Fig 1. Welcome screen
2. The main screen is displayed after a moment.

B User ID : UnKnown

File Calculator

e

System User Help

Fig 2. Main Screen

14
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3.2. Program Operation

The PCR reaction program consists of thermal steps and cycling steps. Up to
30 steps can be set in a single program.

3.2.1. File Library
Click the <File> icon on the main screen to enter the file library screen.

* As shown in Figure 3, this screen shows the file list in the left column and a
preview of the selected file on the right side.

* The selected file can be edited, renamed, deleted, or executed using the
buttons at the bottom of the screen.

B Fie

. File Name: DNA-RNA.cln From User:  Unknown

DNA-RNA.cIn
1 2 B 4
94.0 94.0
| 03:00 00:30
50‘0 55.0
30:00 00:30

Crew | e | noome | ooe | oo | )

Fig 3. File Lirbrary Screen

15
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3.2.2. Create a New File

1. In the File Library screen, click <New> and create a new reaction program.
(Figure 4)

* Enter the temperature and time by using the numeric keys. Set the
number of steps and cycles by using the <+Step> button and the
<+Cycle> button. The maximum number of steps that can be set is 30.

E File->Edit
1

2 3 4 5
grads
0.0°C

94.0 94,0 :

03:00 00:30 720 Z"(;?c/c

50.0 e 00:30

30:00 00:30 time/c
0s
ramp
0.0°C

S i

Fig 4. Reaction Program Setting Screen

2. After completing the reaction program setting, click <Return> and select
<Ok>.

3. After entering the filename in <Name> as shown in Figure 5-1, select
<Ok> to return to the File Library screen.

* A new file is created at this point.

E Files>Rename
B YT | VAT B@

880000000
@@D@@
@@
8000000 =23

---—

Fig 5-1. File Name Input Screen

0.0°C

Note T @ sample
50.0 Save files? /0030 UG

Step time

Total time
01:30:30

N e e

Fig 5-2. Edit File Name Confirmation Screen
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3.2.3. Setting of Options

Settings for the gradient function and the temperature change for each cycle

can be adjusted.

E File->Edit
1

2

94.0
03:00
50.0
30:00

grads
0.0°C

94.0
00:30 72.0

temp/c

0.0°C
550 00:30

00:30 time/c
0s

ramp

0.0°C

([ [ | oiee | opun | seun)

Fig 6. Reaction Program Edit Screen

1. With a step selected in the Reaction Program Edit screen, click the
<Option> button. Then, set the parameters of the steps (Figure 7).

Items of each parameter are as follows:

- Temp
- Time

- +Temp/c :

- +Time/c

- Grads

- Ramp

ﬂ Files >Edit> Options

Temperature setting

Reaction time

Set this when you want to change the temperature for each
cycle, such as when performing a touch-down PCR. If you want
to reduce the temperature by 1°C for each cycle, enter -1.0°C.
Set this when you want to change the reaction time for each
cycle.

Set this when the gradient function is used. Enter the range
of the gradient. The setting temperature is adapted to the
1st column at the left end of the heat block, and the
temperature obtained by adding the gradient range is
adapted to the 12th column at the right end of the heat
block. Gradient is automatically calculated.

The default temperature control is adapted when the ramp
rate is 0.0°C/s. If you want to set a heating and/or cooling
rate that is slower than the default temperature control,
enter the value you want in “ramp”. You can enter 0.1 to
5.0°C, but the value cannot exceed the maximum
heating/cooling rate of the instrument.

/e | ows |

450 450 450 450 450 450 450 450 450 450 450 450
— ]

1 2 3 4

5 6 7 8 9 10 11 12

Fig 7. Optional Parameter Setting Screen

17
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2. After completing the required optional settings, press <Ok> to return to
the Edit screen.

* To return to the Edit screen, click the <Return> button. However, the
option setting is not updated unless you click <Ok>.

3.2.4. Running the Reaction Program

1. In the File Library screen, select the reaction program, and then click
<Run> to execute the program (Figure 8).

The File Library screen contains the following items:

- Lid Off : Select this when the heat lid is not heated. In the column to
the right of the graph, the heat lid and heat block temperature,
elapsed time, and total time of heating are displayed.

- Stop : The reaction program stops.

- Pause : Suspends the running reaction program. The program can be
resumed when the <Start> button is clicked.

- Skip : Skip the program to the next step.

*  The executed step of the reaction program blinks when the program is

running.
2 3 4 5 ] 7
0. EE A e
1 2 3 4 5 - L
7 LI
105.0C
90.0 eSample
00:05 30.5C
60.0/90.0 Step time
00:05 00:00m:s
Total time
00:00:00

(— Twor [ [row [ v | ]

Fig 8. Screen of the running program

2. The Completion screen is displayed when the reaction program running is
finished.

* The heat block temperature after the reaction program is finished is set
to 16°C. Remove the sample immediately after completion of the reaction.

3. After the 2. above is confirmed, stop the reaction program by clicking
<Stop>.

18
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3.3. Calculation of the Temperature Gradient

The Gradient Calculation screen shows the heat block temperature of each
column when the gradient range is set. To set the gradient function in the
reaction program, use <Option> in 3.2.3. Setting of Options.

1.

Click <Calculator> on the main screen to enter the gradient calculation
screen (Figure 9).

u Calculator

v Q99

| Temp | 60.0C ‘
Temp range: 30~99.9C

\i}/\/\_/

| Grads | 300C |
Grads range: 0~30C

o % MioF Ku¥ Kz

[ i e

Fig 9. Gradient Calculation Screen

Enter the heat block temperature in the “Temp” box and the gradient
range in the “Grads” box.

* The heat block temperature entered is applied to the 1st column on the
left of the heat block.

* The range of the gradient entered is added to the heat block
temperature entered and applied to the 12th column of the heat block.

Click <OK> after the entry is completed to calculate the temperature
setting of respective column.

* The calculation is executed automatically.

4. Press <Return> to return to the main screen.

19
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3.4. User Registration

1. Click the <User> icon on the main screen to enter the user management
screen (Figure 10).

E User

Current User: unknown Total:1

a
Username Level

1 admin Administrator

) I~

(| | e[ om [

Fig 10. User Setting Screen

2. Click <Register> and enter your username, password, and other
information in the user registration screen, then click <Ok> to complete
registration.

3. Click <Login> and enter the registered information on the login page in 2.
above to log in.

* To remove the registered user, you must log in as the <Administrator>.

20
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3.5. System Settings

1.

Click <System> on the Main screen to enter the System screen (Figure 11).

System

) Lid Setting

® Lid heating is off O Start up

O When a program starts, Lid heating is on.

© The program does hot start until the lid reaches the specified temperature.

D Hot lid temp % Sample Quantity & Temp control mode
[icsoc | [ o £ @ Book

(@ Date and time settings y N ® Factory settings

| 2000/00/00 00:00:00 [

Version: 000000000

Fig 11. System Settings Screen

The System Settings includes the setting for the timing of heat lid heating,
settings for the heat lid temperature, settings for the temperature control,
settings for the date and time, and login function to the factory settings.
The details of respective items are as follows:

- Lid Setting : Set the timing of heat lid heating.
- Hot lid temp : Set the heat lid temperature.
- Sample Quantity . Enter the quantity of the liquid in the sample

tube according to the calculated value when the
temperature is reached at the tube temperature.
When <Tube> is selected in the next <Temp
control mode> step, the temperature control is
performed taking the entered quantity of the
reaction liquid into consideration.

- Temp control mode : When controlling the temperature, select
whether the set temperature is reached by
attainment of the heat block temperature or
by attainment of the tube temperature. When
<Tube> is selected, the time required to reach
the set temperature is calculated taking the
value entered in Sample Quantity into
consideration.

- Date and time settings : Used to set the date and time of the instrument.

- Factory settings : Used to log in to the Factory mode. The
Factory mode should be exclusively used by
the service engineer where the settings at the
time of shipment from the factory are stored.

- Version : Version of the operating software of the
instrument.

2. After completing the settings, click <Ok> to save them, then click

<Return> to return to the Main screen.

21
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3.6. Import/Export of the Reaction Program

3.6.1.

1.

3.6.2.

Import of the Reaction Program

Turn off the instrument, connect a USB flash drive containing the reaction
program you want to import to the instrument.

. Turn on the instrument and press <Help> on the main screen to enter the

help screen (Figure 12).

Help nﬁpon

Please select a file, Press the import key.

g DNA-RNA.cIn

Upgrade

Fig 12. Reaction Program Import Screen

Click <Import File> on the help screen to switch to the import screen,

select the reaction program you want to import, then click <Import> to

import the program to the current user.

* To cancel selection of the selected file, press <Refresh>. After
completing the procedure, restart the instrument.

Export of the Reaction Program

Turn off the instrument, connect the USB flash drive to which the reaction
program is exported to the instrument, then turn on the instrument.

Select the reaction program to be exported and export the reaction
program to the USB flash drive by clicking <USB Storage> on the screen.

Remove the USB flash drive and restart the instrument after completing
the procedure.

22
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4. Maintenance and Troubleshooting

4.1. Daily Maintenance

Keep the heat block clean. Dirt accumulated on the heat block can affect
the temperature control.

Cool the heat block to a temperature that will not cause skin burns before
wiping it with a diluted neutral detergent (Do not use a solution of strong
bases, alcohol exceeding 70% concentration, or organic solvent).

Do not place any object around the exhaust holes located at the left and
right sides of the instrument.

Keep the air intake holes located at the bottom of the instrument. Dust will
attach to the holes after the instrument is used for certain period of time.

4.2. Replacement of the Fuse

1. Identify the location of the fuse.

* The fuse is located in the fuse holder on the right side of the rear of
the instrument.

2. Loosen the fuse holder with a flathead screwdriver by turning it

90° counterclockwise.
W)

23
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3. Remove the fuse holder.

* The holder consists of two pieces and the inner holder can be pulled out.

4. Replace the old fuse in the holder with the new one*.

*1 The current rating of the fuse is 5A. A spare fuse comes with the
instrument you purchased. However, when you need to purchase a new
fuse, contact your distributor.

N

5. After installing the holder into the position, lock it by turning it
90° clockwise with a flathead screwdriver.

24
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4.3. Error Message

If any of the following error messages appears, checks and repairs are required.
Contact your distributor.

No | Error Message

1 Display Error Open:x Short:x

Display screen not bright and abnormal

Touch failure

Block is not heated

Block temperature is too high/too low

Hot cover is not heated

Hot cover temperature is too high

0 g | |0 |bd|jwW]|DN

Fan can not rotate

25
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5. Related Products

[0.2 ml Single Tube]

0.2 ml Hi-Tube Dome Cap (Cat. #NJ200)
0.2ml Single-Tube Dome Cap (Cat. #NJ204)
0.2ml Single-Tube Flat Cap (Cat. #NJ205)

[0.2 ml 8-Tube & 8-Cap]

0.2 ml Hi-8-Tube (Cat. #NJ300)

0.2 ml Hi-8-Dome Cap (Cat. #NJ301)
0.2 ml Hi-8-Flat Cap (Cat. #NJ302)

[0.2 ml Plate & Cap]

0.2ml 96well-plate for Real Time (Frosted) (Cat. #NJ401)
Flat Cap for PCR Plate (Cat. #NJ402)

96 well snap plate (Cat. #NJ710)

Flat cap for snap plate (Cat. #NJ720)

A Note:
Please be aware that recommended caps must be used for each tube and

plate.
Use of other caps or seal might decrease reaction volume by vaporization.

. Takara Bio Inc., all rights reserved.
Published by httos://www.takarabio.com

v202303
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